
Fifty Tech Tips 
2024

Detroit, MI
May 9, 2024



Glenn Rawdon, LSC
grawdon@lsc.gov

Clarissa Ayala, Lone Star Legal Aid
CAyala@lonestarlegal.org

Angela Tripp, LSC
trippa@lsc.gov

Jane Ribadeneyra, LSC
janerib@lsc.gov

Shellie Reid
Michigan Advocacy Program / LSNTAP
sreid@lsscm.org

Presenter Notes
Presentation Notes
Introduction:

Glenn Rawdon, LSC�grawdon@lsc.gov��Clarissa Ayala, Lone Star Legal Aid�CAyala@lonestarlegal.org ��Angela Tripp, LSC�trippa@lsc.gov��Jane Ribadeneyra, LSC�janerib@lsc.gov��Shellie Reid�Michigan Advocacy Program / LSNTAP�sreic@lsscm.org�

mailto:grawdon@lsc.gov
mailto:CAyala@lonestarlegal.org
mailto:trippa@lsc.gov
mailto:janerib@lsc.gov
mailto:sreid@lsscm.org


Google 
Chrome Task 
Manager

Presenter Notes
Presentation Notes
GR 1

The Google Chrome Task Manager provides a comprehensive overview of the CPU, memory, and network usage for each open tab and plug-in. with a single mouse click, You can also use it to terminate individual processes if something becomes unresponsive or is showing unusual behavior., This is much like the functionality offered by the Windows Task Manager or macOS Activity Monitor. This feature allows for efficient troubleshooting and resource management within the browser.


To open Google Chrome's Task Manager, you can:
Click the three dots in the top right corner
Click More tools
Select Task Manager

Google Chrome's multiprocess architecture is a standout feature that enables tabs to run as independent processes. However, there are times, when Chrome may experience lag, unusual behavior, or a webpage, may become unresponsive, making it challenging to identify the problematic tab. In such situations, the Chrome Task Manager proves to be an invaluable tool.





NEW MICROSOFT TEAMS APP

• LOOK
• PERFORMANCE
• INTEGRATION

CLARISSA’S TECH TIP 1

Presenter Notes
Presentation Notes
CA1
The new Microsoft teams app has a new look and a simpler interface
The cleaner and more intuitive design makes it a breeze for users to find and access the tools they need, boosting productivity and efficiency in our daily tasks.

(PERFORMANCE) The enhanced app is all about lightning-fast performance, ensuring seamless communication and collaboration, even in bandwidth-intensive scenarios. This means real-time teamwork, effortless file sharing, and smooth video calls without any lag or delays. This helps projects progress smoothly.

(INTEGRATION the new Microsoft Teams has been built for better functionality in collaborative apps like Microsoft OneDrive. This expands its capabilities, allowing users to customize their experience based on their specific needs. Imagine having all your Microsoft 365 software and apps—Word, PowerPoint, Excel, OneNote, OneDrive, and more—all in one place. No more juggling browser tabs. 

You can preview and collaborate on Canva designs, use Mentimeter, and access other Microsoft and compatible apps directly within Teams. This consolidated approach not only saves time but also enhances the overall workflow by providing a cohesive workspace for all your essential tools.

And for those of us dealing with background noise during virtual meetings—kids, dogs, or the occasional unexpected interruptions—the updated Microsoft Teams app has you covered. Make sure to take advantage of the improved background noise suppression feature, ensuring your meetings remain focused and professional.



Google Tasks Lists

Presenter Notes
Presentation Notes
Ang 1.0

Google tasks Lists let you create lists and add tasks to those lists and now they have a new view on the side where you can check and uncheck lists like you can in the calendar�
This is great when managing people or projects since you can attach emails to those and set date reminders.�




Bonus tip: add Tasks in Google Docs

Presenter Notes
Presentation Notes
Ang 1.1

Goes with Google Tasks Lists
You can now add tasks within a google doc and assign it to a person, add a due date, and it will show up in their calendar as a pending task with the doc attached. 



Microsoft Windows Hello

Search for Sign-in options in 
Windows Search
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Presentation Notes
JANE TIP 1 

Windows Hello uses facial recognition to sign in to your computer.
In the Windows Search bar, search for Sign-in options. You can also find it from the Start > Settings > Accounts > Sign-in Options

Windows sign-in options and account protection - Microsoft Support

Select Windows Hello Face and toggle it to ‘On’, It will open your computer camera and do a quick facial recognition to get you set up. 

(there are also options to set up Fingerprint) 


When you step away from your computer, press the Windows Logo Key + L to lock it. When you return, just click on the desktop and Windows Hello validates you. 






ReadClearly & WriteClearly
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Presentation Notes
SR1
LSNTAP is happy to announce the release of the Word version of WriteClearly. This project is made possible through a partnership with Urban Insight with funding by the Legal Services Corporation.
WriteClearly analyzes text and uses the Flesch-Kincaid readability test to determine the reading grade level. WriteClearly was originally developed as a web application programming interface (API) by Urban Insight in partnership with Legal Assistance of Western New York, Inc. and Idaho Legal Aid Services with funding from the Legal Services Corporation (LSC). The Google Docs version of WriteClearly was originally created at a hackathon using the WriteClearly API. Currently, maintenance of all versions of WriteClearly is funded by an LSC grant managed by LSNTAP and facilitated through a partnership with Urban Insight.
The new add-in for Word is free and is available through the Microsoft App Source. Step by step directions for downloading and using the add-in are available on Tango. 
Previous versions of WriteClearly are available through the following resources:�The free Google Docs version is available through the Google Workspace Marketplace. Directions for use are available on Tango.�The free web API is available through Open Advocate.

ReadClearly is a  is a free plain language legal glossary for websites. It identifies complex legal terms on a website and displays a plain language explanation. 

https://www.lsntap.org/node/334/readclearly-writeclearly-training-recap
�
�



Google 
AppSheet
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GR 2
Google Appsheet is a no-code development platform that allows users to create mobile and web applications using data from spreadsheets, databases, or other sources, without needing traditional programming skills.

Key points about Google Appsheet:

1. It's a part of the Google Cloud platform and integrates well with other Google services like Google Sheets, Forms, and Drive.

2. Users can create apps by defining data models, user interfaces, and workflows using a visual editor.

3. Appsheet supports various data sources, including Google Sheets, Excel, SQL databases, and cloud-based platforms like Salesforce and Dropbox.

4. It provides a wide range of pre-built templates and features, such as user authentication, data visualization, and geo-location capabilities.

5. Appsheet apps can work offline and sync data when a connection is available.

6. It offers built-in security features, such as user access control and data encryption.

7. Apps created with Appsheet can be deployed on the web, Android, and iOS platforms.

Google Appsheet is designed to democratize app development and enable business users, analysts, and domain experts to create custom applications without relying on professional developers. This can help organizations quickly develop and deploy apps for various purposes, such as data collection, workflow management, and team collaboration.



Word: CTRL+SHIFT+V

Paste into Word 
without any 
formatting
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Presentation Notes
Ang 2.0

Use the shortcut CTRL+SHIFT+V to paste information into MS Word without any of the formatting. It’s a lot easier than pasting it and then clicking on the dropdown, remembering which option is best between use destination theme, keep source formatting, or text only, getting it wrong, doing it again, etc.



RIVERSIDE

• RECORDING 
AUDIO / VIDEO

• LIVE STREAMING 
CAPABILITIES

• INTEGRATION
• TRANSCRIPTION
• SRT (SUBTITLE) 

GENERATOR
LEARN MORE

CLARISSA’S TECH TIP 2
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(RECORDING AUDIO / VIDEO) With Riverside.fm, you can elevate your podcasting or video game by recording remote guests in up to 4K resolution. This feature enables seamless collaboration and precise editing, offering isolated audio and video tracks for each participant. 

(LIVE STREAMING CAPABILITIES) Riverside.fm supports live streaming on platforms like YouTube and Facebook. This functionality allows you to share our content with a broader audience, connecting with your community in real-time. We use this feature for virtual outreach at Lone Star Legal Aid. 

(INTEGRATION) Riverside.fm provides automatic backups and cloud storage for its recordings. This will give you peace of mind when it comes to preserving your valuable content. My account only allows 12 hours worth of video storage a month, so I do have to download and store them elsewhere when I need more room. We’ve been using it lately to record reels with our attorneys to post online. So, that’s something else to note, you can record in riverside and download your video clip in any platform size, like a standard landscape orientation for YouTube or a vertical portrait orientation video for a reel without having to record twice. 

(TRANSCRIPTION) One standout feature of Riverside.fm is its exceptional transcription capabilities. This allows us to edit transcriptions and effortlessly extract specific clips from videos. This innovative feature enables content creators to curate reels and other short-form videos by handpicking quotes or soundbites directly from the transcribed content. In addition, when you delete from the transcript in Riverside, it automatically deletes that section of video. 

Example of efficiency: We recently uploaded a 2-hour interview with our CEO, and Riverside.fm transcribed it in just 2 hours. This would have taken us days, if not a week, to accomplish manually.

(SRT GENERATOR) Riverside.fm provides an SRT generator for its content. It is part of what is done automatically when recording within the platform, but also works with outside content. If you have video or audio recorded outside of Riverside, simply upload it, and the platform will produce an SRT file. This file can be used for subtitles, adding an extra layer of accessibility and engagement to your content.

Potential Applications at Your Organization

Staff Meetings
Organizational Meetings
For these internal meetings, you can use the transcription, Redact any protected information to make sure you’re hipaa compliant, and ask Chat.GPT to create meeting minutes with detailed notes on the meeting based on the transcript.
Client Interviews (?) 
You’d have to get their permission to record first. It would be similar to recording a zoom meeting. OR only record attorney advice to transcribe and send as a follow-up to the client



Add Name Pronunciation to Email Signature
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JANE TIP 2 (Slide 1 of 2)

NameCoach is a tool that allows you to record and share the pronunciation of your name. 

It’s available as an Outlook App: https://appsource.microsoft.com/en-us/product/office/WA200004562?tab=Overview

To add NameCoach to your Outlook, you need to:
In the top ribbon banner, click Get add-ins.
Type NameCoach in the search bar and click Add.
Click Continue to agree to license terms.
A NameCoach tab will open upon installation.
On your NameCoach Dashboard page, click on the Add NameBadge to your Email Signature tab and copy the code you need to your clipboard.
In the Outlook desktop app, open a new email window, click on Signature, and select Signatures.
Click on New to create a signature and edit it with your information.
Paste the code you copied from NameCoach to add your NameBadge to your signature.

Can also go to https://cloud.name-coach.com/ to Signup as an Individual.




NameCoach Outlook Add-In
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Once you have your audio recorded, You can edit your signature in Outlook to add the NameCoach icon and link your audio file to it. 

https://production-processed-recordings.s3.amazonaws.com/af2d54bcabca18cb1c7c5a7b37193427.wav

https://production-processed-recordings.s3.amazonaws.com/af2d54bcabca18cb1c7c5a7b37193427.wav


Cornell 
Feline Health Center’s 

CatGPT
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Press coverage: https://news.cornell.edu/stories/2024/03/cornell-feline-health-center-launches-playful-catgpt


Requires an OpenAI account to get answers other than meows
The chatbot uses articles from the Feline Health Center’s website and scientific publication abstracts:

CatGPT is available in OpenAI’s ChatGPT app store, which features custom-built chatbots that focus on a range of topics and pull information and data from selected sources rather than the general internet. For now, access requires a subscription to ChatGPT Plus.

Beyond the fun aspect, cat gpt is just one example of AI usage by Cornell. Schools and units across campus submitted project ideas and an AI team helped bring the project to life. Cornell hopes that these many AI projects will give insight into the future of AI and how AI will transform research, the administration, and the teaching at Cornell in the future.



Adobe Acrobat 
Compare Files

• What Can It Do? Compare two 
PDF files to identify differences 
(text, images, layout).

• Why Useful? Collaboration, 
version control, and accuracy.

Presenter Notes
Presentation Notes
GR 3.1
Adobe Acrobat's compare files feature is a tool that allows users to identify differences between two PDF files. This feature is useful when you have multiple versions of a PDF document and want to see what has changed between them.

Key points about Adobe Acrobat's compare files feature:

1. It compares two PDF files and highlights the differences between them.

2. The differences can include text, images, annotations, and formatting changes.

3. Acrobat displays the two PDFs side by side, with the differences marked in colored boxes.

4. You can navigate through the differences using the "Next Difference" and "Previous Difference" buttons.

5. The compare feature can also generate a report that summarizes the differences between the two files.

6. You can choose to compare specific aspects of the PDFs, such as text only or annotations only.

7. The compared documents can be saved as a new PDF file with the differences highlighted.

This feature is particularly useful in legal, business, or editorial contexts where it's important to track changes between versions of a document. It saves time and reduces the risk of overlooking important changes when compared to manually reviewing two versions of a PDF.



CLARISSA’S TECH TIP 3

CANVA FOR 
PRESENTATIONS

• CURATED LIBRARY 
OF MODERN 
TEMPLATES

• ROYALTY-FREE 
GRAPHICS

• DATA-DRIVEN 
CHARTS

• COLLABORATION
• LIVE PRESENTATION 

POLLING

Presenter Notes
Presentation Notes
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Canva offers a refreshingly intuitive platform that empowers you to craft visually stunning and professionally branded presentations effortlessly. And the best part? It won't cost your nonprofit a dime!

Access a curated library of modern tech templates, each designed to captivate your audience.

Customize with Canva's drag-and-drop interface. Tailor fonts, images, and layouts to align perfectly with your organization's brand guidelines.

Canva provides royalty-free graphics and data-driven charts to elevate your message. Plus, add a personal touch with audio narration, making your presentation truly memorable.

Collaboration is seamless with Canva's real-time editing and commenting features. Work together with your team to refine your presentation until it's just right. And when it comes time to present, Canva has you covered with built-in tools for speaker notes and transitions, ensuring a polished and engaging delivery.

But wait, there's more! Want to interact with your audience? Canva lets you share a QR Code to instantly poll them, creating an immersive experience for everyone involved.



LM Studio (lmstudio.ai)
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LM Studio is a game-changer for anyone curious about the latest advancements in large language models (LLMs) but finds the barrier to entry daunting. You may have heard of open-source LLMs like Llama and Mistral, but actually experimenting with these models can be a challenge. LM Studio simplifies this process, allowing you to dive into the world of LLMs without the usual complexities. It's an excellent tool for both beginners and seasoned professionals looking to see what the hype is about—or isn't. For more information and to try it out for yourself, visit their website -- https://lmstudio.ai/



With LM Studio, you can ...🤖 - Run LLMs on your laptop, entirely offline👾 - Use models through the in-app Chat UI or an OpenAI compatible local server📂 - Download any compatible model files from HuggingFace 🤗 repositories🔭 - Discover new & noteworthy LLMs in the app's home pageLM Studio supports any ggml Llama, MPT, and StarCoder model on Hugging Face (Llama 2, Orca, Vicuna, Nous Hermes, WizardCoder, MPT, etc.)
Minimum requirements: M1/M2/M3 Mac, or a Windows PC with a processor that supports AVX2. Linux is available in beta.
Made possible thanks to the llama.cpp project.




MS Word:
Check for 
Inclusiveness
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You may already be using Microsoft Editor to check for spelling and grammar in your writing. Here’s something else Editor can do – it will show you suggestions to help your content be more inclusive.

You will need to check your Editor Settings:
Open a Microsoft Word document
From the Home tab, select Editor, then select Grammar and Options at the bottom of the Grammar window.

Review all the options under Inclusiveness that you want it to review, and click ‘OK’

It will check for any potential bias language, including age, gender, racial, and sexual orientation bias.

See also How to check for inclusive language in Microsoft Word (ithinkdiff.com)



Email to Trello
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Creating cards by email
You can create cards on a board by writing or forwarding an email to Trello.
To get your email address for a board, log in to Trello in the browser and open the board you would like to create cards by email on. Open the Menu in the right sidebar and then click on "Email-to-board". From here, you can select the list in which the emailed card will be created. You can click on the current list name ('None' in the below example) to change that to a different list. 
You can also have your email address for that board emailed to you. Please note that the email address is unique for each board and board member. Also, comments must be enabled for the board in order to generate the email-to-board address.
The card will show up in the next few minutes after the email is sent.
Each Trello board has a unique email address.

Formatting tips
When you email a card to Trello, you can immediately add attachments, labels, and members to the card, in addition to setting the title and description.
The Subject of the email becomes the card's title.
The Body of the email becomes the card's description.
Attachments in the email will be added to the card.
Labels: In the subject, add #labelname, #labelcolor, or #labelnumber
If your label consists of two or more words, in the subject line either join the words or use underscores between the words. For example, if your label is named "To Do" in the subject line of your email either enter #ToDo or #To_Do for the label to render properly on your card.
If you have multiple labels on a board with the same color or the same name, emailing a board with #color or #name will only add the first label with that color or name to the card.
Members: In the subject, add @username. Members can also be added by putting @username in the body of the email on its own line. If you send an email to Trello and include other Trello users' email addresses as "to" or "CC" addresses, Trello will add them as members of the card as well.
Attachments and email size
Most emails with attachments will make it into Trello just fine. However, there is an overall email size limit (above 10MB) that will prevent cards from being created via email. If this happens, your mail server may send you a message that it was unable to send the email.
Any images inserted into the email's body will be added as an attachment in the card, rather than being kept in the card description. 
Email threads and duplicated cards
The first time a message is sent to the board email address, it will create a new card. If replying to the email the messages will be added to the original card as comments. This could happen when the board email address is added to a long email thread, and it is designed this way to prevent duplicated cards. Only replies to or forwards from the original email that created the card will result in a comment being added to the card. To maintain the threaded comments in the card, be sure to forward the original email message or add the board email in the BCC field on your responses.
Cards created using the board email will get tied only for 7 days. After this period, new replies to the email thread will generate a new card instead of adding them as comments to the original card.
Email comments to card 
Each card also has its own email– sending a note to this address will make your email show up as a comment. You can find a card's email under the "Share" button on the card back, in the bottom right corner. 

https://trello.com/power-ups



Windows 
Clipboard History

What is It? Enhanced clipboard functionality.

How to Use? Press Win+V to access clipboard history.

Why Use It? Store multiple copied items and paste them when needed.

Get Started: Windows 11 Clipboard History

Presenter Notes
Presentation Notes
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Windows 11 Clipboard history is a feature that enables users to access multiple items they have recently copied or cut, instead of being limited to just the most recent item. This feature was first introduced in Windows 10 and has been carried over to Windows 11.

Key points about Windows 11 Clipboard history:

1. It stores a history of text, HTML, and images (less than 4MB) that you have copied or cut.

2. You can access your Clipboard history by pressing Win + V on your keyboard.

3. The Clipboard history window allows you to select and paste any of the stored items.

4. Items in the Clipboard history are synced across devices when you have the sync setting enabled.

5. You can pin frequently used items to keep them in the Clipboard history permanently.

6. The Clipboard history can be cleared entirely or selectively.

7. Users can enable or disable the Clipboard history feature in Windows Settings.

This feature is particularly useful when you need to copy and paste multiple items quickly or if you accidentally overwrite your clipboard and need access to previously copied items.



CANVA FOR SOCIAL 
MEDIA SCHEDULING

01 Cost-effective alternative to paid 
programs like Hootsuite

02 Streamlined social media 
management

CLARISSA’S TECH TIP 4

Presenter Notes
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Cost-effective alternative to paid programs like Hootsuite: Canva offers a scheduling feature that eliminates the need for costly social media management tools. With Canva, you can schedule posts directly within the platform, saving your nonprofit valuable resources that can be redirected towards other impactful initiatives.

Streamlined social media management: Canva allows you to seamlessly connect your Facebook, Instagram, Twitter, and other social media accounts, streamlining the process of content creation and distribution. This integration empowers busy professionals, marketers, and content creators to focus on what matters most: crafting impactful content that resonates with their audience, without the hassle of switching between multiple platforms.



Google’s Notebook LM (video)
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Google's NotebookLM represents Google's foray into the world of AI education and notetaking. It’s a pretty amazing set of features if you’re trying to learn something new. Here’s a quick video: https://www.youtube.com/watch?v=dWy_VKu9Sl0&ab_channel=EdTechHustle

https://www.youtube.com/watch?v=dWy_VKu9Sl0&ab_channel=EdTechHustle


Outlook Calendar Sharing

Presenter Notes
Presentation Notes
JANE TIP 4 (Slide 1 of 2)

Allow people in your company and/or team to view your calendar by permission levels.
 
Go to Outlook - Options - Calendar - "Change the permissions for viewing Free/Busy information" click the Free/Busy Options button. 

Bonus: Uncheck the box to "Add online meeting to all meetings"




Outlook Calendar Sharing
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Select My Organization

Under Permissions, select the default setting that will apply to everyone. By choosing “Can view titles and locations” it can provide a little bit of information that can be helpful to colleagues when scheduling meetings. You can always set any appointment as Private.

You can add certain staff or team members to provide a higher (or lower) level of permissions.




Opt Out Prescreen
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OptOutPrescreen.com is the official Consumer Credit Reporting Industry website to accept and process requests from consumers to Opt-In or Opt-Out of firm offers of credit or insurance. Through the site you can opt out of offers for five years or permanently. (You can later opt in again)


https://www.optoutprescreen.com/



Storage Sense in Windows

What Does It Do? Automatically 
frees up disk space by removing 

unnecessary files.

Why Use It? Keep your system 
optimized and organized.

How to Access It: Open Settings, 
select System, then Storage.

Presenter Notes
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Storage Sense is a feature in Windows 11 that helps you manage and free up disk space automatically. It can be configured to regularly remove unnecessary files, such as temporary files, downloaded files, and the contents of your Recycle Bin.

To access Storage Sense in Windows 11:

1. Open the Settings app by pressing Win + I or clicking on the Start menu and selecting "Settings."

2. Click on "System" in the left-hand menu.

3. In the "System" menu, click on "Storage."

4. Under the "Storage management" section, you'll find "Storage Sense."

Reasons to use Storage Sense:

1. Automatically frees up disk space: Storage Sense can be set to run automatically, ensuring that your disk space is regularly optimized without manual intervention.

2. Removes unnecessary files: It can delete temporary files, downloaded files, and the contents of your Recycle Bin that are no longer needed, freeing up valuable storage space.

3. Customizable settings: You can configure Storage Sense to run on a schedule (e.g., every day, week, or month) and specify which types of files it should remove.

4. Helps maintain system performance: By regularly freeing up disk space, Storage Sense can help maintain your system's performance and prevent low disk space issues that could slow down your computer.

5. Easy to use: With Storage Sense, you don't need to manually search for and delete unnecessary files, saving you time and effort.

Overall, Storage Sense is a convenient tool that can help you keep your Windows 11 computer running smoothly by automatically managing your storage space.



DRAG AND DROP IN 
TRELLO

01 Intuitive Drag-and-
Drop Interface

02 Flexible Board 
Customization

03 Versatile Card 
Customization

CLARISSA’S TECH TIP 5
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Trello boards serve as the main organizational structure for projects. Users can create multiple boards for different projects, teams, or purposes. 

Trello's drag-and-drop interface makes it easy to move cards around within a board or across boards. 

Users can simply click and hold a card, then drag it to a different position within the same list or to another list on the same board. Additionally, users can drag cards from one board and drop them onto another board, facilitating seamless collaboration and project management.



Paint 3D – New and Improved version of Microsoft Paint!
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Microsoft has revamped Paint, transforming it into a tool that's both super cool and surprisingly powerful. A recent update has introduced features that leverage AI, making it a fascinating tool for both casual and serious creatives. To see these new features in action and get a sense of how Paint can now contribute to your digital artistry or graphic work, check out the overview on YouTube: Watch Microsoft Paint's Transformation. AI infused; co-creator with Dolly. Background removal (button at the top); Dark mode support – settings in upper right, including dark mode); Co-creator with powered by DALL-E; layers – hide and show different layers, work on different layers, arrange orders of layers, etc..



Send Meeting Request/Availability from 
Outlook’s Mobile App
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When you’re away from your office and you need to set up a meeting or reply to an email with a meeting request, you can use Outlook’s Mobile App to Create a Calendar Event or Send Availability for a Meeting from Outlook’s Mobile App.

Reply to someone’s email (or create a new email)
Select the Calendar icon in the bottom left corner
Select “Convert to Event” or “Send Availability” 
You can set the date and time for the meeting, or select times you are available from your calendar, and send the meeting request or your availability.




Point & Speak on 
an iPhone

Presenter Notes
Presentation Notes
SR5
I phone operating system 17 has increased the tools available using the Magnifier
On supported models and for selected languages, you can use the Magnifier app to point to any interactive labels in your environment to have your iPhone speak their text out loud.
When several knobs or buttons have small text labels, you can use Point and Speak, and your iPhone will read the text so you can tell them apart. You can use this for objects with text labels such as:
Digital screens, like grocery self-checkouts
Keypads
Folders in a file cabinet
Household appliances
ATMs

Open the Magnifier app  on your iPhone.
Tap the Detection Mode button
Tap the Point & Speak button , aim your lens at whatever you want read aloud, then point your finger to identify which text to read.

To change how you point to a label, while in Detection Mode tap  (in the top-left corner), tap Point and Speak, then below Location, tap Under (to read text under your fingertip) or Above (to read text directly above your finger).


Or if you use VoiceOver, you can enable Detection Mode
0:20
by triple-tapping the screen with four fingers from any app.




https://support.apple.com/guide/iphone/read-aloud-text-and-labels-around-you-iph29dbe3fb6/17.0/ios/17.0



The Evolution of Microsoft Copilot

What is Microsoft Copilot? AI-
powered code assistance for 

developers.

How Has It Evolved? From Copilot to 
Copilot++.

Try It: Free version is available by 
clicking the Copilot Icon in the upper 

right-hand corner of MS Edge

Presenter Notes
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Microsoft offers three versions of Copilot to its users:
Free Copilot: This version is available to everyone using Windows, Microsoft Edge, or the Bing website. It pulls data from Bing searches and other aggregated information tracked by Microsoft. The generative results are based on internal sources, external sources via Bing Search, and various custom data sources. It’s suitable for general use and provides answers to general questions1.
Copilot Pro: Available to everyone using Windows, Microsoft Edge, or the Bing website, this version requires an additional $20/month subscription fee. Copilot Pro offers priority access to GPT-4 and GPT-4 Turbo during high traffic times. It’s ideal for small businesses (SMBs) that need reliability and speed12.
Copilot 365: This version is specifically for Microsoft 365 subscribers who pay an additional $30/month/user subscription fee. It caters to SMBs and enterprises with large data pools. Copilot 365 provides specific answers to specific questions and utilizes organizational data generated internally1.
Choose the version that aligns best with your needs and business requirements! 🚀




OUTWRITE FOR 
GOOGLE DOCS & 
MORE

01
OutWrite provides essential 
editing features, including 
word count, grammar, and 
spelling checks.

02
OutWrite Pro provides 
advanced capabilities such as 
tone analysis and plagiarism 
detection. 

CLARISSA’S TECH TIP 6
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Comprehensive Writing Enhancement: OutWrite and OutWrite Pro are powerful writing tools designed to elevate the writing experience. OutWrite provides essential editing features, including grammar and spelling checks, while OutWrite Pro introduces advanced capabilities such as tone analysis and plagiarism detection. These tools not only ensure technical accuracy but also offer intelligent suggestions for style enhancements, providing valuable insights to enhance the overall quality of your writing. 

Additionally, OutWrite works seamlessly across various online platforms, including Google Docs, MS Word, Outlook, Gmail, LinkedIn, WordPress, and more, ensuring writers can access its benefits wherever they write online.



Le Chat – Mistral AI (mistral.ai)

Presenter Notes
Presentation Notes
Ang 6.0

Le Chat is a relatively new player in the realm of publicly available LLMs, brought to you by the French company Mistral AI. While it might not surpass all the paid LLMs out there, it holds its own, especially when compared to Google's offerings. Currently in open beta, Le Chat is accessible for anyone looking to explore its capabilities. Despite being developed by a French company, the English version of Le Chat performs impressively well. This makes it a worthwhile option for those exploring LLM technologies. Find out more and sign up to try Le Chat at Mistral AI's News Section.



Permission 
Slip by 

Consumer 
Reports

https://permissionslipcr.com

Presenter Notes
Presentation Notes
JANE TIP 6 (Slide 1 of 2)

Regain Control of your data with the Consumer Reports’ Permission Slip app. They make it easy to send a request to companies to stop selling your personal information or to ask them to delete your data. 





https://permissionslipcr.com

Presenter Notes
Presentation Notes
JANE TIP 6 (Slide 2 of 2)

For instance, I know how much people love Ticketmaster – by using Permission Slip, you can easily send them a request to stop selling or delete your data. 






Google image 
reverse search

Presenter Notes
Presentation Notes
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When using the  Google Chrome browser, Right-click on the image and press the S key to reverse search an image on Google. 
You can also right-click on the image and select ‘search with Google Lens’ to run the image search.
 Google allows you to adjust the area of focus on the image when running the search.





Microsoft Edge’s Collections Feature

WHAT IS IT? A TOOL TO ORGANIZE 
WEB CONTENT.

HOW TO USE? SAVE, CATEGORIZE, 
AND SHARE WEB SNIPPETS.

Presenter Notes
Presentation Notes
GR 7
Microsoft Edge Collections is a built-in feature of the Microsoft Edge web browser that allows users to gather, organize, and share content from the web more efficiently. It enables users to collect images, text, links, and other information from different websites and store them in a single place for later reference or sharing.

Key features and benefits of Microsoft Edge Collections:

1. Content gathering: Users can easily add web content to a Collection by right-clicking on an item or using the "Add current page" button in the Collections pane.

2. Organization: Collections allows users to categorize saved content into separate, customizable groups, making it easier to find and manage information.

3. Notes and annotations: Users can add their own notes to collected items, providing context or reminders for later reference.

4. Sharing: Collections can be easily shared with others via a unique URL, allowing for collaboration and quick sharing of research or ideas.

5. Export options: Users can export their Collections to various formats, such as Excel, Word, or Pinterest, depending on their needs.

6. Accessibility: The Collections feature is easily accessible from the browser's toolbar, making it convenient to use while browsing the web.

7. Sync across devices: Collections can be synced across multiple devices when users are signed in with their Microsoft account, allowing for seamless access to saved content.

Microsoft Edge Collections is particularly useful for researchers, students, or anyone who frequently gathers information from the web and needs a more organized way to store and manage that content.



ZOTERO

• EFFICIENT RESEARCH ORGANIZATION
• SEAMLESS CITATION MANAGEMENT
• COLLABORATIVE CAPABILITIES

CLARISSA’S TECH TIP 7

Presenter Notes
Presentation Notes
CA7
Zotero streamlines research organization and citation process.

How to Use Zotero - 

Download the Zotero Desktop App and Install Browser Extension.

Click on the little book icon (extension) to save sources to specific research topics

Collect all sources, then highlight them and click "create bibliography"

Ability to take snapshots of websites and add them to your research

Key Features - 

Automatically detects research material as you browse the web

Collects articles, preprints, news stories, and books from various sources like JSTOR, arXiv.org, New York Times, and libraries

Organize research by creating collections and tagging with keywords

Create saved searches that update with relevant materials
Supports over 10,000 citation styles for formatting work according to style guides or publications

Syncing and Collaboration - 

Sync data across devices to keep files, notes, and bibliographic records up to date

Access research from any web browser if synced

Collaborate with others by co-writing papers, distributing course materials, or building collaborative bibliographies
Share Zotero library with multiple people for free



Keeping Up On AI – Two Options

One Useful Thing – Ethan Mollick – 
oneusefulthing.org

The Neuron – Daily Newsletter – 
theneutrondaily.com

Presenter Notes
Presentation Notes
Ang 7.0

One Useful Thing is Ethan Mollick's innovative AI-focused Substack that delves into how AI is reshaping the workplace. It's a treasure trove for anyone looking to stay ahead of the curve on AI's impact on various industries, including legal and nonprofit sectors. The insights offered are practical, grounded in real-world applications, and devoid of unnecessary hype. Subscribe to One Useful Thing for regular updates and insights: One Useful Thing Substack.

The Neuron stands out as a daily AI newsletter that cuts through the noise, offering news and innovations in the AI space with an objective lens. Its free Intro to ChatGPT course is a valuable resource for anyone starting their journey into the world of AI and large language models. What makes The Neuron particularly appealing is its commitment to straightforward, hype-free content, likely a reflection of the founders' backgrounds in the public library sector. This approach resonates well with professionals in legal services and nonprofit management, seeking reliable and practical AI insights. Discover more and subscribe at The Neuron Daily.





PDFGear - Free PDF Software

https://www.pdfgear.com 

Presenter Notes
Presentation Notes
JANE TIP 7 (Slide 1 of 2)

PDFGear - Free PDF Software, including an integrated AI tool for interacting with PDFs.

Go to https://www.pdfgear.com to download the software. It has over 30 tools to edit, merge, crop, OCR, extract, organize, etc. Convert PDFs to Word, Excel or JPEG files (or vice versa).

PDF AI Chatbot – integrates with ChatGPT to allow you to chat with your PDF document, to summarize or analyze your PDF. 


PDFgear - Bring Accessible PDF Software to the Masses




PDFGear – AI Powered Chatbot & Copilot

https://www.pdfgear.com 

Presenter Notes
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JANE TIP 7 (Slide 2 of 2)

PDF AI Chatbot – integrates with ChatGPT to allow you to chat with your PDF document, to summarize or analyze your PDF. It also has a PDFGear Copilot feature that allows you to use natural language processing to do tasks like convert your PDF to Word.

PDFgear - Bring Accessible PDF Software to the Masses




Create table of 
contents in PowerPoint

• On the View tab, select Outline view
• In the Thumbnails pane, right click 

and select Collapse All
• Select the slide titles and Copy
• On the View tab, revert to the Normal 

view
• In the text box of your Table of 

Content slide, use Paste Special and 
select formatted or unformatted text.
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Create table of contents in PowerPoint

On the View tab, select Outline view
In the Thumbnails pane, right click and select Collapse All
Select the slide titles and Copy
On the View tab, revert to the Normal view
In the text box of your Table of Content slide, use Paste Special and select formatted or unformatted text

You can also copy and paste into other documents as I did for all of the 50 tech tips presentations since 2017.

https://support.microsoft.com/en-us/office/manually-create-a-table-of-contents-in-powerpoint-b811d08d-f0ca-45c9-b7a4-0243310fb3c1



The ReadQuick App

What is It? A speed-reading tool.

Why Use It? Improve reading efficiency by training your eyes.

Try It Out: Discover the power of rapid reading.

Presenter Notes
Presentation Notes
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Readquick is a speed reading app available for iOS devices. It aims to help users read faster and more efficiently by displaying text one word at a time, reducing eye movement and increasing focus.

Key features and benefits of Readquick:

1. Rapid Serial Visual Presentation (RSVP): Readquick uses RSVP technology to display words one at a time at a user-defined speed, allowing for faster reading and improved comprehension.

2. Customizable display: Users can adjust the text size, color, and background to create a comfortable reading experience.

3. Speed control: The app allows users to adjust the reading speed from 100 to 2,000 words per minute, accommodating different reading levels and preferences.

4. Built-in library: Readquick has a built-in library where users can import articles, documents, and ebooks from various sources, including Pocket, Instapaper, and Dropbox.

5. Progress tracking: The app tracks reading progress, including time spent reading, total words read, and estimated time saved compared to traditional reading methods.

6. Offline reading: Articles and documents saved in the Readquick library can be read offline, making it convenient for users to read on the go without an internet connection.

7. Spritz integration: Readquick supports Spritz, a speed reading technology that enhances reading speed and comprehension by aligning words to the optimal recognition point (ORP) in the reader's field of vision.

The app is designed for individuals looking to improve their reading speed and efficiency, such as students, professionals, and avid readers. By utilizing RSVP and Spritz technologies, Readquick aims to make reading faster and more engaging.



NORTON 360 DELUXE NORTON SECURE VPN

FREE SECURITY TOOLS AND BEST PRACTICES FOR SURVIVORS OF DOMESTIC 
VIOLENCE FROM NORTON

CLARISSA’S TECH TIP 8

You can request these offers for free on TechSoup and distribute them to domestic violence survivors at: https://www.techsoup.org/norton-sdv 

Presenter Notes
Presentation Notes
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Domestic abusers often use victims' digital presence and online activities to track their location, monitor their activities, or reestablish contact. They may also turn to cybercrime tactics to glean information or hack into a survivor's email or social media accounts. A combination of security practices can be used to help prevent abusers from accessing someone's digital life, and robust cybersecurity software is a great place to start.

For survivors, up-to-date antivirus and anti-malware software is a solid first line of defense. Using VPN software adds an extra layer of protection against unwanted intrusions into their online activities.

Norton 360 Deluxe protects computers and mobile devices against the latest digital threats, such as malware, ransomware, and spyware. Its built-in firewall also protects against uninvited connections to computers and other devices. This makes it more difficult to steal information or make dangerous changes to a device.

Norton Secure VPN protects personal information when using shared devices or Wi-Fi networks. This also helps to protect people from unwanted connections, as well as shielding identities from others and preventing connections from being intercepted.

TechSoup has partnered with Norton and the National Network to End Domestic Violence (NNEDV) to provide domestic violence survivors with software to protect their devices and online presence. Organizations working with domestic violence survivors can access and distribute these tools to people who need them.

You can request these offers for free on TechSoup and distribute them to domestic violence survivors here: https://www.techsoup.org/norton-sdv 



Claude 3 – anthropic.com
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Claude 3 is the latest iteration from Anthropic, standing out in the crowded field of ChatGPT competitors. Released in early March, Claude 3 has been making waves by outperforming GPT-4 in many large language model evaluations. What sets Claude 3 apart is its unparalleled ability to produce writing that feels natural, clear, and professional. Running text through Claude 3 with a prompt to "Proofread the following text, fixing any typos and improving clarity and overall writing quality, while maintaining the same tone and style" can significantly enhance your writing quality. This level of refinement in output makes Claude 3 an exceptional tool for anyone looking to elevate their writing. Explore more about Claude 3 at Anthropic's official website or through tech reviews for firsthand experiences.



TechSoup Digital Skills Center: 
AI Skill-Building Resources
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JANE TIP 8

TechSoup Digital Skills Center - AI Skill-Building Resources

We’ve had a prior tip about the TechSoup Digital Skills Center, but this is an update to that to talk about their new resources on using AI for nonprofits. They have a series of Webinars, including an introduction to AI and how to use it for nonprofit work, expert advice on ethics and governance of Generative AI, and how to write good AI prompts.



TechSoup Digital Skills Center: 
AI Skill-Building Resources

Presenter Notes
Presentation Notes
JANE TIP 8 (Slide 2 of 2)

TechSoup Digital Skills Center - AI Skill-Building Resources

They also have Videos and Guides, including ones on Getting Started with Microsoft Copilot, using Excel’s Forecast feature, and considerations for creating an AI Usage Policy.



Quickly Check & delete 
browser history
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Did you accidentally close a browser tab? You can retrieve it with ease. Click Control + Shift + T on Windows and Command + Shift + T on Mac. You can use the command any number of times. https://www.everythingenchanting.com/easy-technical-hacks-you-must-know-everyday-use/

View Google Chrome history:

https://support.google.com/chrome/answer/95589?hl=en&co=GENIE.Platform%3DDesktop#zippy=%2Cfind-a-page-from-your-history%2Cfind-your-history

Microsoft Edge: 
Clear browsing data stored on your device
To clear your Microsoft Edge browsing data, first decide if you want to delete the data only on the device you're currently using, or across all synced devices. To clear browsing data just on the device you're currently using, make sure sync is turned off. If you want to clear browsing data on all synced devices, make sure you are signed in and sync is turned on.  Items that are synced will be cleared across all synced devices.
To turn off sync: 
Select Settings and more .
Go to Settings  > Profiles > Sync  and select Turn off sync. 
To clear your browsing data in Microsoft Edge:
Select Settings and more  > Settings  > Privacy, search, and services .
Under Clear browsing data > Clear browsing data now, select Choose what to clear.
Under Time range, choose a time range from the drop-down menu.
Choose the types of browsing data you want to clear (see the table below for descriptions).�For example, you may want to remove browsing history and cookies but keep passwords and form fill data.
Select Clear now.
https://support.microsoft.com/en-us/microsoft-edge/view-and-delete-browser-history-in-microsoft-edge-00cf7943-a9e1-975a-a33d-ac10ce454ca4



Meeting Insights in MS 
Outlook

WHAT CAN IT DO? 
EXTRACT RELEVANT 

DETAILS FROM 
MEETINGS.

WHY USE IT? 
SUMMARIZE 

DISCUSSIONS, ACTION 
ITEMS, AND FOLLOW-

UPS.

STAY ORGANIZED: 
LEVERAGE THIS 

FEATURE IN OUTLOOK.
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Meeting Insights is a feature in Microsoft Outlook that uses artificial intelligence to provide users with relevant information and tools to help them prepare for and follow up on meetings more effectively. This feature is available in Outlook on the web, Outlook for Windows, and Outlook for Mac.

Key features and benefits of Meeting Insights:

1. Meeting Recap: After a meeting, Meeting Insights automatically generates a summary that includes the meeting's key points, decisions made, and any action items assigned to participants.

2. People Insights: Meeting Insights provides information about the meeting participants, such as their role in the organization, recent documents they've worked on, and their communication history with the user.

3. Email Insights: The feature surfaces relevant emails and attachments related to the meeting, making it easier for users to find and reference important information.

4. File Recommendations: Meeting Insights recommends relevant files and documents based on the meeting's context, helping users quickly access the information they need.

5. Agenda Suggestions: When scheduling a meeting, Meeting Insights can suggest agenda items based on previous meetings and email conversations, saving users time in meeting preparation.

6. Action Items: The feature can automatically detect and highlight action items discussed during the meeting, making it easier for participants to follow up on their assigned tasks.

7. Integration with Microsoft Teams: Meeting Insights integrates with Microsoft Teams, allowing users to access insights and recommendations directly within the Teams interface.

Meeting Insights aims to streamline the meeting experience and improve productivity by providing users with contextually relevant information and tools to prepare for, participate in, and follow up on meetings more effectively.



GOOGLE BARD IS NOW 
GEMINI

CLARISSA’S TECH TIP 9

• GEMINI 
VARIATIONS

• GEMINI V. 
CHATGPT

Presenter Notes
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Google Bard was renamed to Gemini on February 8, 2024, for a few key reasons:

1. The name "Gemini" directly references the underlying LLM (Large Language Model) technology powering the chatbot. This shift aimed to showcase the advanced AI driving Bard's capabilities.

2. Google wants to consolidate its AI presence under a single, clear brand name. Moving all AI experiences under the "Gemini" umbrella streamlines messaging and creates a more cohesive ecosystem.

3. Google believes "Gemini" is more accessible and easier to remember compared to "Bard." This potentially expands the user base and makes the technology more approachable.

4. "Gemini" hints at the ambitious future of the technology. Google suggests Gemini might rival and even surpass GPT-4, another advanced LLM. The new name reflects this potential for growth and evolution.

Overall, the shift from Bard to Gemini signifies Google's commitment to developing powerful AI technology and making it more accessible to a wider audience.

**Here's a breakdown of Gemini variations and how they compare to OpenAI's ChatGPT:

Gemini Variations:

Gemini and Gemini Advanced are both powered by Google's AI technology, but they offer different levels of capability:

Gemini: This is the base version, freely available to users. It can handle a wide range of tasks, including answering your questions in an informative way, generating different creative text formats, and translating languages.

Gemini Advanced: This is a premium version that requires a subscription to the Google One AI Premium plan. It unlocks the full potential of Gemini, granting access to Gemini Ultra, Google's most advanced AI model. This translates to enhanced abilities in:

Reasoning: Gemini Advanced can better analyze complex problems and situations, offering more insightful solutions.

Coding: It can assist you with coding tasks more effectively, understanding and generating code at a deeper level.
Creative Collaboration: If you need help brainstorming ideas or crafting creative content, Gemini Advanced can be a powerful partner.

Key Differences:

Data Source: ChatGPT uses a predefined dataset (GPT-3.5: up to Sept 2022, GPT-4: up to April 2023), while Gemini pulls data from the real-time internet, offering potentially more up-to-date responses.

Capabilities: Gemini is a multimodal model, meaning it can handle text, code, images, and even video processing, while ChatGPT is primarily focused on text.

Availability: Currently, ChatGPT is more accessible (free and paid tiers), while Gemini Pro is in developer release.

Choosing Between Them:

Accessibility: If you need a free or readily available option, ChatGPT is easier to get started with.

Performance: If you require top-notch reasoning and access to real-time information, Gemini Ultra (once available) might be the better choice.

Multimodality: If you need an AI for tasks beyond text, Gemini's ability to handle different data types is a clear advantage.

Here are some resources for further reading:

A comparison of their performance: https://www.tomsguide.com/ai/google-gemini-vs-openai-chatgpt
A breakdown of their key differences: https://www.zdnet.com/article/chatgpt-vs-microsoft-copilot-vs-gemini-which-is-the-best-ai-chatbot/



Rescue Closed 
Browser Tabs CTRL + SHIFT + T
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Works on chrome, edge, firefox; shift+command+t for mac
Can open one tab, keep hitting for multiple tabs, and if you close the whole window, one strike will bring them all back. This is your undo feature for tabs – if you accidently close the wrong tab because you have 50 open and the x’s are too small, or you close a few tabs and then realize you need to go back to one from a bit ago, or if your computer decides to do an upgradeor restart while you’ve gone to get a cup of coffee – you’ll be able to restore all your 50-70 of your tabs, so you can get back to work.



Microsoft Training for Nonprofits
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Training your staff to use the technology tools you have is an ongoing challenge. Microsoft provides a lot of free training resources, including ones specifically for nonprofits. Training is self-paced and moves you from Beginner to Intermediate to Advanced

https://www.microsoft.com/en-us/nonprofits/resources?rtc=2&activetab=pivot1:primaryr3



Use Google as a 
Stopwatch or Timer
On your desktop:

• On the Google homepage, type the following in the search bar:
• Set a timer for “X” minutes/hours

or
• Start a stopwatch

In a Google Doc:

• Type @ to open the Smart Canvas tools and select the Timer or 
Stopwatch “Smart Chip” (they also may appear at the top of a 
new doc)

Presenter Notes
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1. Setting a timer
Just go to Google’s homepage and type in ‘Set a timer for X minutes/hours.’ Doing this will automatically load a timer above several search results and begin counting down.
The same thing can be done from the URL bar in Chrome if you don’t want to navigate all of the way to the search engine before setting a timer.

2. Setting a stopwatch
Just like with the timer, you can start a stopwatch right from Google’s homepage. To do it, just type ‘Start a stopwatch‘ in the search bar. Once it’s running, you can start, stop, and restart the stopwatch.
Additionally, you can get to the stopwatch from Chrome’s URL bar or by clicking on it in the tab above the timer.

https://9to5google.com/2018/02/09/how-to-set-timer-stopwatch-google-homepage-android-basics/#:~:text=Steps%20to%20set%20a%20timer%20or%20stopwatch%20from%20Google's%20homepage&text=Just%20go%20to%20Google's%20homepage,results%20and%20begin%20counting%20down 

Have a timer or stopwatch in a Google Doc: https://chromeunboxed.com/google-docs-smart-canvas-timer-stopwatch
Start a timer or stopwatch in Google’s browser:  https://9to5google.com/2018/02/09/how-to-set-timer-stopwatch-google-homepage-android-basics/

There is a similar feature for Microsoft Word, but it takes an extra step or two.



Multiple Desktops 
in Windows 11

• What Are They? Separate workspaces for multitasking.

• How to Create? Use Win+Tab and add new desktops.

• Why Use Them? Keep tasks organized and reduce 
clutter.
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Multiple Desktops, also known as Virtual Desktops, is a feature in Windows 10 and Windows 11 that allows users to create and manage separate virtual workspaces on a single computer. Each desktop can have its own set of open windows and applications, helping users organize their work and reduce clutter on their screen.

Key features and benefits of Multiple Desktops:

1. Organization: Users can group related tasks, projects, or applications on separate desktops, making it easier to focus on specific work without distractions.

2. Productivity: By separating work and personal tasks, or different projects, users can switch between desktops quickly and maintain focus on the task at hand.

3. Multitasking: Multiple Desktops allow users to run and manage multiple applications simultaneously without cluttering a single desktop.

4. Privacy: When sharing a screen or working in a public space, users can keep sensitive information or personal tasks on a separate desktop, ensuring privacy.

5. Customization: Each virtual desktop can have its own unique wallpaper, making it easier to visually distinguish between different workspaces.

To access and manage Multiple Desktops:

1. Click on the Task View button in the taskbar (the icon looks like two overlapping rectangles), or press Win + Tab on your keyboard.

2. Click on "New Desktop" in the Task View window to create a new virtual desktop.

3. To switch between desktops, click on the desired desktop in the Task View window or use the keyboard shortcuts Win + Ctrl + Left/Right Arrow.

4. To move applications between desktops, open the Task View window, right-click on the application window, and select "Move to" followed by the target desktop.

Multiple Desktops offer a convenient way to organize and manage multiple tasks, projects, or workspaces on a single computer, improving productivity and reducing clutter.



HIPCAMP
HIPCAMP CAN BE THOUGHT OF AS THE 

AIRBNB FOR CAMPING ENTHUSIASTS. IT'S 
AN ONLINE MARKETPLACE SPECIFICALLY 

FOCUSED ON OUTDOOR STAYS AND 
CAMPING EXPERIENCES.

CLARISSA’S TECH TIP 10
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Here's the breakdown of what Hipcamp offers:

For Campers: Hipcamp allows you to discover and book unique campsites on private land. It goes beyond traditional public campgrounds, offering options like:

Tent camping spots
RV Parks with hookups
Glamping (glamorous camping) with pre-set tents or accommodations
Unique options like cabins or treehouses
For Landowners:  If you have land with suitable space, you can list it on Hipcamp and:

Earn extra income by renting out campsites
Help people experience the outdoors while potentially contributing to land conservation efforts
Similarities to Airbnb:

Both connect people with unique spaces to stay.
Users can search and book listings based on various criteria like location, amenities, and activities.
Differences from Airbnb:

Hipcamp focuses solely on outdoor stays, whereas Airbnb offers a wider range of property types (apartments, houses, etc.).
Hipcamp listings might be more rustic or unique compared to typical Airbnb rentals.



Ending iPad Screentime Fights*

• Add the iPad and your iPhone to 
Family Sharing

• Create child account
• Set time limits, or schedule 

downtime
• Enables you to turn off the iPad 

using your phone

*Tip only valid for Apple devices, may 
not work with all children/family 
members, smiling child not guaranteed 

Presenter Notes
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How to link your family's apple devices so you can remotely control their devices (i.e., mysteriously make the Ipad turn off even when someone wants to keep playing minecraft on it after you've said it's time to stop).



Cooked - Your 
Smart Cookbook
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Cooked – a Smart Cookbook. When I look for a new recipe to try, I turn to the internet, but when I see something interesting, I have to scroll down pages and pages of photos and ads just to try to find the recipe. Now you can use a free tool called Cooked.

1. Simply add "cooked.wiki/" in front of the URL in your browser's address bar when you're browsing for a recipe.

Generate recipe from any website
Unlimited saved recipes
Unlimited journal and photos
Unlimited community access
Access your friends journal
Convert any recipe to printable pdf
QR code on every recipe
scan with your phone to open recipe
Smart recipe recommendations for ingredients
Adjust portions automatically on any recipe
Recipe dictation for hands free cooking
limited to robotic voices
Screen does not lock while reading recipe
on supported devices
Export all your recipes in one-click
we do not gatekeep your data
We do not collect personal data
providing email is optional



https://cooked.wiki/
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By adding https://cooked.wiki/ in front of the URL of the recipe you want to cook, it will create a simple page with just the recipe and a shopping list that you can print or save to your Cooked account. By saving recipes, you can create your own personal cookbook and easily share recipes with friends and family.

https://cooked.wiki/



Wikipedia-print 
format
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Wikipedia articles are great but can be a nightmare to print’
�Go to the Wikipedia page you want to download. To search for a page, go to https://www.wikipedia.com, then type a word or phrase into the search bar.
�Click Tools. You'll see this drop-down menu in the upper-right area of the page below the language menu. A drop-down menu will expand.
Click Download as PDF. This is under "Print/export" in the drop-down menu. This will redirect you to a page that includes a download link. The page will display the message Please wait while the document is being generated. The process won't take more than a minute to complete.Immediately after it, the page will refresh automatically and a download link will be generated.

https://www.wikihow.com/Download-a-Wikipedia-Page-as-a-PDF


In partnership with PediaPress, Wikipedia enables readers of its online encyclopedia to create collections of Wikipedia articles and to order these directly as high-quality print-to-order books. 10% of the gross sales cost from books sold in this way go to the Wikimedia Foundation. Books created in this way can also be downloaded in PDF or OpenDocument format free-of-charge.
The Wikimedia Foundation also plans to release a CD/DVD or print version of Wikipedia as an encyclopedia.

https://www.wikihow.com/Download-a-Wikipedia-Page-as-a-PDF




Fever 
Travel App
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Fever is a travel app that helps people discover events and experiences in cities around the world. The app is free but tickets and tours do have charges.

Description: Fever curates the best events and experiences in major cities. From concerts to secret pop-ups, it ensures users never miss out.
Features: Exclusive events, personalized recommendations, and user reviews.
Reviews: Users appreciate the curated selection of events and the app's user-friendly interface.
Price: Free app, prices vary for events.


https://blog.flutter.wtf/cool-apps/



Thank You! 
Questions and Discussion
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